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At the current stage, it is necessary to utilize the latest information technologies based on paperless 

storage, processing, and exchange of information to organize effective, timely, and high-quality specialized 

surgical assistance. Therefore, one of the tasks of this research was developing and implementing an information 

and analytical system for monitoring children receiving treatment for echinococcosis using a universal 

personalized electronic database. 

This medical information and analytical system, intended for monitoring the therapeutic and diagnostic 

process, ensures the maintenance of clinical records about a patient and their review, processing, and analysis. 

This is particularly important for enhancing the efficiency of scientific research and the therapeutic process 

according to operational management criteria, which include reducing the time to obtain diagnostic information, 

increasing the reliability of examination results, and timely analytical processing based on a unified information 

space. 

Developed for specialized pediatric hospitals, the medical information and analytical system (MIAS) 

"Echinococcosis in Children," implemented in the practice of the Specialized Children's Surgical Clinic of 

Samarkand State Medical University, managed the registration of all children admitted to the clinic with 

echinococcosis, as well as the monitoring of therapeutic and diagnostic measures conducted for the patient and 

the registration of patient movements, both within the clinic and in case of transfer to other institutions. After the 

discharge of patients, MIAS provided cumulative information about the patients, which was stored in the database. 

The program "Echinococcosis in Children" is written in C# using Microsoft Visual Studio Net 2008 and 

offers a universal development intended for building a complex analytical application to study echinococcosis in 

children. 

The program interface is designed so that working with the menu, forms for data entry, and editing is 

understandable even to an untrained user. Special attention is paid to the maximally simplified and accelerated 

data input. 

The "Echinococcosis in Children" program includes multifunctional reporting, analysis, and data 

visualization tools. The program consists of the following sections: forms, reports, macros, and modules. The 

Forms section - each form is designed to display relevant information, correct data entry based on given 

conditions, and present detailed information about each patient with echinococcosis in a convenient graphical 

form. The Reports section - presents ready-made reports on each parameter of interest and their combinations 

with detailed quantitative analysis in graphical form. It allows the simultaneous use of different data sources in 

one report. The Macros section - stores macro commands used to solve the most typical and frequently 

encountered tasks in building this information system. The Modules section - stores program codes used during 

various events when working in forms and codes generated in macros. 

The program is delivered as a .msi installer file. Upon launching it, a splash screen appears (Figure 1), 

allowing access to the main menu. 

The software allows for the creation of specific forms and queries based on existing data. Button 

locations in the main window allow access to any program window (Figure 2). 
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Figure 1. The Startup Page Of The Program. 

 

 
Figure 2. The Main Window Will Appear When The Program Is Opened. 

 

Technological design of the main window. On the top toolbar of the window, there are 6 buttons. The 

"File" button opens the existing database or saves the changes made. The "Data" button opens a window to record 

a new patient, precise data, or delete the current record. The "Charts" button converts digital data into graphical 

forms. The "OLAP (Pivot Tables)" button converts multi-level analysis data into pivot tables. The "Reports 

(Print)" button carries out the printing of compiled reports. The "Complex Data Analysis" button highlights data 

analysis in four variants.  

The middle toolbar on the left has five functional and four technological buttons. The "Patient List" 

button opens a list of all registered patients with the sequence number, year of admission, surname, first name, 

age, category of residence, and detection of echinococcosis. The "Table" button opens a tabular version of the 

data presentation for all patients (Figure 3). Tables allow for rapid data analysis in a user-friendly format. The 

number of parameters that can be entered is virtually unlimited. 
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Figure 3. "Table" 

 

*Opening an existing database. If there is already a file with data, it needs to be opened to continue 

working with it. The data file is text in XML format and has the extension .echinococcus. The data loading time 

depends on the amount of data and the computer's 'power.' On average, it takes a few seconds. 

We are creating a new database and filling out the main form for a patient. The procedure for adding a 

new patient is as follows: 'Menu' > 'Data' > 'New Patient.' 

If a data file still needs to be created, creating a new database will be the same as when adding a new 

patient: 'Menu' > 'Data' > 'New Patient.' After this, you can fill out the leading 'Patient' form. 

On the toolbar of the main form, there are 17 tabs containing objective information about the patient. 

These can be filled out immediately upon admission or as data is received. There is a button for printing and a 

backup button for entering additional information. 

In the main form's 'General Features' section, features were registered or automatically calculated, 

including those in accounting form 066 ('Discharged Patient Card') and those additionally entered. This 

significantly saved staff time spent on routine calculations. 

The next tab of the main form involves entering ICD codes for various types of echinococcosis (B67 - 

B67.9), as well as the residential areas of the patients. The medical information and analytical system 

'Echinococcosis in Children' was developed for conditions such as endemic areas of the Republic of Uzbekistan 

as well as all subjects of the Russian Federation. The application of the program is also intended in other CIS 

countries. This page includes ICD directories (10th Revision), subjects of the Russian Federation, CIS countries, 

regions of the Republic of Uzbekistan, and districts of the Samarkand region, where MIAS was tested. Subsequent 

tabs are dedicated to entering the results of the therapeutic-diagnostic process on the 'Shares and Segments of the 

Liver. In the kidney tab (Figure 4), the localization of echinococcal cysts by liver segments or location in specific 

kidneys is indicated. 

 

 
Figure 4. Localization of echinococcal cysts in the liver (kidneys). 
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On the next tab, the localization of echinococcal cysts in the lung tissue is recorded, indicating the 

segments (Figure 5). 

 

 
Figure 5. Localization of echinococcal cysts in the lungs. 

 

The program has a detailed section on complications (3 buttons). It thoroughly records and describes 

preoperative complications and complications that arise during and after surgical interventions. 

Local and general features of complications, which are divided by organs and systems, are considered. 

Diagnostic tabs included results of laboratory tests for echinococcosis, general and biochemical blood 

analyses, coagulograms, immunological tests at admission and discharge, pH-metry, and gastric juice analysis. 

Two windows contain information about the surgical interventions performed, including accesses, the 

type of operation, methods of closing the residual cavity, and types of drainage. 

The next tab describes the localization of echinococcal cysts, the nature and volume of their contents, 

the timing characteristics of therapeutic manipulations, and the correspondence of morphological data to 

radiological and ultrasound findings. 

MIAS 'Echinococcosis in Children' offers extensive capabilities for introducing and storing graphic 

information, primarily digitized radiograms and ultrasound data (Figure 6). Saving in formats such as BMP, 

JPEG, TIFF, DICOM, AVI, DVD, MPEG, and others is possible. 

 

 
Figure 6. Ultrasound. 
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I. Data Analysis 
Systematization of information using filters.  

The "Filters (group selection)" button opens 46 installed filters, with which data analysis can be conducted. 

Data analysis is fundamentally performed in two stages. In the first stage, a group for analysis is created 

using filters, and in the second, the created group is analyzed using various parameters. The simplest way to make 

a group for analysis is to use ready-made filters in the "Filters" tab. This results in data filtration, i.e., only the 

data that meets the filter conditions are displayed. 

It should be noted that items with a paperclip icon do not perform filtering but are merely logical headers. 

Filtering is performed only when an item with a filter icon is selected. 

More detailed information about working with scripts can be found in specialized literature on ADO.Net 

technology. 

Data Sorting. The sorting tab offers ready-made sorting parameters. Sorting can be performed by order 

in the database, surname, age, or admission date. 

The "all records" button disables filtering and restores sorting, changing the indicator's appearance. 

Analysis of created groups (general principles). Analysis of groups created through filtering (at the first 

stage) can be conducted in various ways. Four groups are opened by the "Complex Data Analysis" button. 

In any case, only the data selected through the filter is analyzed. If filtering is not defined and all data 

are displayed, all data will be analyzed. 

The groups created were analyzed using the information panel to classify forms of echinococcosis. It 

displays the general characteristics of echinococcosis manifestations, including its main forms, prevalence, sizes 

of echinococcal cysts, timing of disease detection and treatment, and patient residences. 

Analysis using OLAP (pivot tables). OLAP is one of the fastest and most effective data analysis methods, 

possessing extensive capabilities. OLAP helps create robust pivot tables that allow users to thoroughly study and 

analyze the entered information. Data in pivot tables are easily grouped, filtered, collapsed, expanded, aggregated, 

and ranked (Figure 7). 

 

 
Figure 7. OLAP Multidimensional Analysis Window. 

 

Pivot tables allow for analyzing 3-4 data groups in various combinations (Figure 8). 

 

 
Figure 8. Example of Pivot Table Usage. 
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A pivot table is fundamentally constructed by dragging and dropping database fields onto the X and Y 

axes. The constructor is called up using the 'magic wand' button. 

On the 'Layout' tab of the Pivot Table Wizard, all database fields are displayed on the left, with unused 

fields in the center (for convenience). This tab is typically used to quickly drag the most frequently used fields 

onto the X and Y axes and the fact fields. In this case, a fact field is presented, which counts the number of records 

for the corresponding fields on the axes. 

 

On the 'Table Styles' tab, properties for the external formatting of the pivot table are set. 

The 'Header and Footer' tab defines the output of headers and footers in the table, including their 

properties, such as various fills, fonts, etc. 

 

II. Data Visualization 
The program integrates various charts, indicators, and information panels. The following charts are 

included: bar, line, pie, financial charts, histograms, etc. The indicator library includes counters, dialers, sliders, 

switches, digital panels, and other circular and linear instruments. Both charts and indicators are made in the same 

styles, which does not cause difficulties in their combined use, for example, in information panels. The program 

contains graph and indicator designers for the end user. 

In analytical work, it is convenient to present existing data graphically. To save, the obtained charts are 

copied to the clipboard or a file. 

Analysis of treatment costs. The application of information technologies in healthcare at the current stage 

aligns with a critical task, such as evaluating the efficiency of financial resource utilization. In the development 

of MIAS 'Echinococcosis in Children,' the research task did not include conducting a complete economic 

calculation of the cost of treating a patient, which contains maximum accounting of medical and non-medical, 

direct and indirect costs, as there are special accounting programs (such as 'Parus' and others). Nevertheless, the 

developers included in the program the possibility of evaluating the treatment methods from a financial 

perspective because the outcome of the entire healthcare facility's medical and economic work will depend on 

how effectively the allocated funds are spent. 

The criteria for evaluating medical assistance's financial viability included the outcomes of diseases after 

various surgical treatment methods, the number of bed days spent by the patient in intensive care and surgery 

departments, and the cost of bed days in the respective departments. 

It is necessary to consider that this counting model is compiled with a certain degree of conditionality, 

as the cost of a bed-day in the surgery and intensive care departments is calculated on average for all patients in 

these departments. 

The 'Complex Data Analysis' tab is opened on the top panel, and the 'Analysis of the Cost of Treatment 

of the Study Group' option is selected (Figure 9). 

 

 
Figure 9. Analysis of the Cost of Treatment of the Study Group. 
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The hospital's treatment costs consist of intensive care and surgical bed days. In the program, the cost of 

all records by the filter is summed up: (total bed-days - intensive care bed-days) x cost per bed-day in the surgical 

department + number of intensive care bed-days x cost per intensive care bed-day. Considering possible rate 

changes, the cost of a bed-day for surgical and intensive care beds is not fixed. The cost of a surgical and intensive 

care bed-day and the currency unit are filled in by the user and saved in the program when the 'calculate' button 

is pressed. 

The system's capabilities can be demonstrated by a practical example of determining economic indicators 

of treatment by various methods for patients with echinococcosis at the Samarkand branch of pediatric surgery of 

the RSNPMC Pediatrics. 

In the 'Analysis of the Cost of Treatment of the Study Group' window, one can view the cost of treatment 

for individual patients by grouping them. Groups can be selected based on diagnoses and treatment methods. The 

number of patients and the cost of their treatment according to the cost of bed days are calculated automatically. 

 

III. Results Of Determining The Cost Of Treating Patients. 
For analysis, the following groups of patients were selected: A) 198 patients with liver echinococcosis 

operated from 2002 to 2010; B) 115 patients with liver echinococcosis operated from 1998 to 2001; C) 150 

patients with lung echinococcosis operated from 2002 to 2010; D) 104 patients with lung echinococcosis operated 

from 1998 to 2001. 

Calculation method: A) 198 patients underwent Nк-дн.-хир. (3017) and Nк-дн.-реан (238). X = (Nк-

дн.-хир. :194) x $ хир+ (Nк-дн.-реан. :194) x $ реан. 

 

Where: 

X - Average cost of treating one patient; 

(Nк-дн.-хир. :194) - Avg. bed-day in surgery dept.; 

$ хир - Cost of bed-day in surgery dept.; 

(Nк-дн.-реан. :194) - Avg. bed-day in ICU; 

$ реан - Cost of bed-day in ICU. 

a) X = (3017/198) x 1515 + (238/198) x 5550 = 23084 + 6671 = 29755 

b) X = (2752/115) x 1515 + (192/115) x 5550 = 36254 + 9266 = 45520 

c) X = (3160/150) x 1555 + (216/150) x 5550 = 32758 + 7992 = 40750 

d) X = (2661/104) x 1555 + (229/104) x 5550 = 39788 + 12220 = 52008 

Or even simpler (data from MIAS): 

A) Total cost for 194 patients: 194 = X1 

B) Total cost for 110 patients: 110 = X2 

(X2 – X1) x 110 = economic efficiency 

A) 5891655/198 = 29755 

B) 5234880/115 = 45520 

(45520-29755) x 115 = 1812975 

(52008-40750) x 104 = 1170832 

Perform calculations for other groups using this formula. 

If we compare groups A, B, C, and D, the cost of treatment in the main group will be lower than in the 

control group. 

Determine the difference in treating one patient with liver echinococcosis and lung echinococcosis 

between the main and control groups and multiply it by the number of patients in the control group. This will be 

the economic efficiency (if modern methods treated them). 

Thus, improving the treatment methods for children with various forms of echinococcosis improves 

medical indicators and has a certain economic effect. 

 

Results of operation of the medical information-analytical system "Echinococcosis in Children" at the 

Specialized Pediatric Surgical Clinic of Samarkand State Medical University.  

A model was created for the collection and further analysis of data on patients with echinococcosis, and 

based on it, MIAS "Echinococcosis in Children" was developed, which was tested during the input and processing 

of information on the results of the clinic's work from 1998 to 2010. The created database contains information 

on 627 inpatients. The developed MIAS was operated at a single medical registrar's workstation, where input 

from the center's disease history cards was performed. The database fill rate reached 100%, allowing a 

retrospective analysis of the quality of care provided. Analysis of activity through reports and forms allowed 

determining the number of patients treated for echinococcosis, the structure of pathology and surgical 

interventions, the characteristics of disease and injury courses, outcomes, etc. 
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IV. Conclusion 
The functionality of the medical information-analytical system we developed includes: 

Information collection, registration, and structuring. MIAS receives primary information users enter 

(system operator, attending physician, research associate, etc.) and data from other specialized systems. 

Information structuring and standardization are carried out at the input stage, speeding up processing. 

Information exchange and the creation of a unified information space. MIAS allows users simultaneous 

access to the necessary information and controls medical documentation maintenance. 

Storage and search for information. Thanks to a unified database, it is possible to quickly find the 

necessary information about a patient and avoid duplication of information when a patient seeks medical help 

again. 

Statistical and scientific data analysis. Doctors, heads of medical institutions, and research associates 

can conveniently obtain the necessary summary information for further study. 

Control of the effectiveness and quality of medical care provided. MIAS allows assessing medical care 

results and monitoring compliance with all necessary standards. 

Convenient work with medical documentation. Using MIAS, a doctor can conduct a critical analysis of 

therapeutic measures and compile a review of previously taken decisions to control the quality of treatment. 

MIAS software product "Echinococcosis in Children" was created considering the specifics of pediatric 

hospital operations without information technology specialists. The simplicity and ease of training staff, the speed 

of data entry, and the universality of obtaining information make it universal in the work of medical institutions. 

The presented information-analytical system has solved many practical and scientific questions in 

evaluating the treatment of echinococcosis in children. It can easily be integrated into a pediatric hospital's full-

fledged information system at the subsystem level without replacing it. 

The system's apparent advantages are a wide range of tools in the form of ready-made reports and the 

ability to create new complex reports with minimal time expenditure. Interactive presentation of data from 

summary reports in graphical form makes it convenient for analyzing scientific information. The program 

includes a designer who will lay out fields along axes and the styles of the pivot table for the end user. All software 

components are fully compatible with other .Net data. 

Practical experience of working with MIAS "Echinococcosis in Children" on processing long-term data 

at the Specialized Pediatric Surgical Clinic of Samarkand State Medical University, which included 627 children, 

showed its high effectiveness in scientific information analysis and ease of system mastery. 

Due to its simplicity and accessibility, implementing the MIAS "Echinococcosis in Children" system in 

Republican and regional pediatric centers seems promising. This system will ensure the timeliness of data 

processing, treatment results analysis, and economic efficiency indicators. 

 

 

 


